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Introduction
Electronic Signatures for Microsoft Dynamics® GP enables companies to increase 
control over their system changes. Electronic Signatures supports one or more 
electronic signature authorizations for system changes, as well as the ability to 
attach electronic signature reason codes and comments to change history. Electronic 
Signatures provides controls to help companies meet the requirements of data 
compliance regulations such as FDA 21 CFR Part 11 and the Sarbanes-Oxley Act. 

Electronic Signatures includes the following features:

• Allows you to set up electronic signatures to approve important system 
changes.

• Works with any Microsoft Dynamics GP modules or Microsoft® Dexterity®-
based, third-party developed modules.

• Supports one or more password authorizations and the capture of electronic 
signature reason codes and comments on specified system changes.

• Provides control of individual electronic signature assignments and passwords.

This introduction includes the following topics: 

• What’s in this manual?
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual?

This manual contains step-by-step instructions that guide you through the 
installation and set up of Electronic Signatures, as well as instructions for using the 
product.

This manual assumes that you are familiar with navigation principles in Microsoft 
Dynamics GP and that you know how to operate the Microsoft Dynamics GP 
business system. It also assumes that the latest release of Microsoft Dynamics GP 
has been installed and configured on your computer.

To make the best use of Electronic Signatures, you should have a working 
knowledge of each Microsoft Dynamics GP module that you use with Electronic 
Signatures. Electronic Signatures integrates with every Microsoft Dynamics GP 
module, the Microsoft Dynamics GP system database, and Dexterity-based, third-
party developed modules.

This manual contains the following chapters:

• Chapter 1, “Electronic Signatures overview,” includes an explanation of how 
electronic signatures work and a perspective on deciding where to apply 
electronic signatures.

• Chapter 2, “Setup,” explains how to set up electronic signatures for a company.

• Chapter 3, “Electronic Signatures workflow,” explains how to set up Workflow 
for Electronic Signatures.
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• Chapter 4, “Working with Electronic Signatures,” explains how to:

• Approve system changes with electronic signatures
• Access change history information associated with electronic signatures
• Define e-mail addresses used to request remote approval
• Respond to remote notifications

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation, and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be especially 
aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in a 
window. This example directs you to go to the File menu and choose 
Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Electronic Signatures overview
This part of the documentation presents an overview of Electronic Signatures. This 
information is divided into the following sections:

• How the Electronic Signatures feature works
• Deciding where to apply electronic signatures
• Terminology used in Electronic Signatures documentation

How the Electronic Signatures feature works

Electronic Signatures applies preventive controls on changes to fields or windows 
within Microsoft Dynamics GP. When a user attempts to complete a system change 
that is controlled by an electronic signature, a window is displayed that requires one 
or more authorized passwords to be entered before the system change can be 
completed.

Electronic signatures can be applied to most windows and fields within Microsoft 
Dynamics GP. Electronic signatures can’t be used to restrict changes within 
scrolling windows.

Deciding where to apply electronic signatures

Electronic signatures are typically applied to the fields and windows in Microsoft 
Dynamics GP that require preventive controls according to your business processes 
and the needs of your organization. To decide where you should set up electronic 
signatures:

• Identify the points within Microsoft Dynamics GP that require preventive 
control.

• Decide who within the organization should be authorized to release the control.

• Decide what information should be captured at the point of the control, and 
what rules should apply to capturing this information.

You can hide the Reason Code and Comment fields, or provide them as options or as 
requirements.

Creating electronic signatures requires an understanding of the Microsoft Dynamics 
GP windows and field names. We recommend using Electronic Signatures in a test 
environment before activating it in your business routines.

Terminology used in Electronic Signatures 
documentation

The term “electronic signature” is used in two ways. First it refers to the application 
of a process hold on changes to a Microsoft Dynamics GP window, which requires 
the change to be reviewed and approved before it’s saved. It also refers to the 
password that’s entered when a change requires approval.

In addition, the following terms are used throughout the Electronic Signatures 
documentation.
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Approver The person that enters an electronic signature (password) to authorize 
a system change.

Authorize The process of entering an electronic signature (password) to approve 
a system change.

Remote user A user that’s not in proximity to the requestor. The approver does 
not have to be using Microsoft Dynamics GP to be notified that an electronic 
signature is required.

Requestor A user that enters a change to a record that requires authorization 
from an approver.
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Chapter 2: Setup
This chapter covers the process of setting up Electronic Signatures. Information is 
divided into the following sections:

• Installing Electronic Signatures
• Granting access to Electronic Signatures
• Creating electronic signatures
• Adding an electronic signature to the Item Maintenance window
• Creating an electronic signature reason code
• Setting up electronic signature authorizations

Installing Electronic Signatures

After you install Microsoft Dynamics GP, you must complete an additional 
installation step to prepare Electronic Signatures for use. 

To install Electronic Signatures:
1. Open the Install Electronic Signatures window. 

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Install 
Electronic Signatures)

2. Click Install to complete the installation. The installation process creates tables 
and stored procedures for Electronic Signatures.

3. When the installation finishes, click OK to close the Install Electronic Signatures 
window. 

Granting access to Electronic Signatures

During installation, the ESROLE security role was created with the 
ESMAINTENANCE security task assigned to it. To provide access to Electronic 
Signatures windows, you must add the users that will be working with Electronic 
Signatures to ESROLE security role. 



8 E L E C T R O N I C S I G N A T U R E S

To grant access to Electronic Signatures:
1. Open the User Security Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> System >> User Security)

2. Enter or select a user that works with Electronic Signatures.

3. Select a company in which the selected user should have access to Electronic 
Signatures. 

4. Select the ESROLE security role. 

5. Click save. 

Creating electronic signatures

Electronic signatures are set up in windows associated with the records, or 
electronic documents that you want to control. For example, you might want to 
require an electronic signature password when a change is made to an inventory 
item, which is contained in the Item Master table and changed in the Item 
Maintenance window.

Before creating an electronic signature, determine the following information for 
each place it is to be assigned:

• Product
• Series
• Form name
• Window name
• Attachment resources (for example, the button that saves the document or 

closes the window)
• Record keys (only editable, non-blank fields can be used for record keys)

The following data types can be used for Attachment Resources: string, text, integer, 
tiny integer, long integer, currency, vcurrency, real, checkbox, drop-down list, and 
date. No other data types are currently supported.

If you’re not familiar with Dexterity technical names for forms, fields, and windows, use the 
Resource Descriptions utility to find this information (Microsoft Dynamics GP menu >> 
Tools >> Resource Descriptions >> Windows). The window name can also be found by 
opening up the window for which you want to set up an electronic signature. The window 
name is found at the top of the window in the title bar.
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Adding an electronic signature to the Item 
Maintenance window

Use the Signature Setup window to add electronic signature passwords for master 
records. The following procedure lists the steps for adding an electronic signature to 
an item record. The process is similar for adding electronic signatures to other 
master records.

To add an electronic signature to the Item Maintenance 
window:
1. Open the Signature Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Electronic 
Signatures >> Signature Setup)

 

2. Enter the following fields as needed for the Item Maintenance window:

3. Select Item Number in the Record Key 1 field. It’s important to use the field that 
uniquely identifies the record, in this case, Item Number is the identifier for 
each item record used in Microsoft Dynamics. If additional record keys are 
needed, select them in the subsequent record key fields.

If you’re not familiar with Dexterity technical names for forms, fields, and windows, 
use the Resource Descriptions utility to find this information (Microsoft Dynamics GP 
menu >> Tools >> Resource Descriptions >> Windows). The window name can also be 
found by opening up the window for which you want to set up an electronic signature. 
The window name is found at the top of the window in the title bar.

Field Entry

Label Enter a label to identify the signature

Product Microsoft Dynamics GP

Series Inventory

Form Name IV_Item_Maintenance

Window Name IV_Item_Maintenance

Attachment Resource Item Description
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4. Select the information that’s collected when an electronic signature is used. You 
can enter and save electronic signature reason codes, comments or both when 
an electronic signature is entered. For more information about reason codes, see 
Creating an electronic signature reason code.

5. Indicate the capture options that will be applied to the information you collect. 
There are three capture options for electronic signature reason codes and 
comments:

Hide Excludes this field from the Signature Entry window. The user will not 
be able to see or use this field. 

Provide Allows—but does not require—users to enter information in this 
field. 

Require Requires the user to enter information into the field for the electronic 
signature to be valid.

The icons in the following tables indicate the status of reason codes and 
comments.

6. Choose Save. You must log out of Microsoft Dynamics GP and log in again for 
changes to take effect.

Creating an electronic signature reason code

Electronic signature reason codes are user-defined codes that a user can (or must) 
select before entering an electronic signature. Each electronic signature can have its 
own set of reason codes. An unlimited number of reason codes can be created for 
each electronic signature.

To create an electronic signature reason code:
1. Open the Signature Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Electronic 
Signatures >> Signature Setup)

Symbol or color Description

R Indicates a reason code

Black Reason codes are available

Red Reason codes are required when an electronic signature is 
entered

Yellow Reason codes haven’t been set up for the selected signature

C Indicates a comment

Black Comments can be entered when the electronic signature is 
entered

Red Comments must be entered when the electronic signature is 
entered
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2. Choose the GoTo button and select Reason Codes to open the Signature Reason 
Code Entry window.

3. Select an electronic signature to enter a reason code for. Existing electronic 
signatures are displayed in the upper part of the window. The Signature name 
appears in the Signature field.

4. Enter a reason code and description.

5. Choose the disk icon button to save the reason code. The reason code is 
displayed in the detail section at the bottom of the window.

Setting up electronic signature authorizations

Use the Signature Authorization window to specify the users that can approve 
system changes. When a user attempts to change a field or window that is 
controlled by an electronic signature, a window opens that requires a password 
(electronic signature) to be entered before the change is saved. More than one user 
can be authorized to use an electronic signature password to approve a system 
change. 

To set up an electronic signature authorization:
1. Open the Signature Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Electronic 
Signatures >> Signature Setup)
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2. Choose the GoTo button and select Signature Authorization to open the 
Signature Authorization window.

3. Select an electronic signature to assign users to. Existing electronic signatures 
appear in the upper section of the window. The signature label appears in the 
Signature field. 

4. Choose the user ID lookup button and select the user that’s authorized to 
approve a system change using the selected electronic signature.

5. Choose the disk icon button to save the authorized user ID. The authorized 
user ID is displayed in the detail section at the bottom of the window.

6. Choose Done.
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Chapter 3: Electronic Signatures workflow
If your company uses the Workflow feature among its business controls, changes 
that require electronic signatures can be approved by someone who doesn’t use 
Microsoft Dynamics GP. When a change is made that causes the Signature Entry 
window to open, users can submit the change for workflow approval. The 
workflow task appears on the Microsoft Dynamics Workflow site, where an 
authorized person can approve it.

Before you can use workflow for Electronic Signatures, the following components 
must be installed and configured:

• Microsoft Dynamics GP, including Electronic Signatures
• Web Services for Microsoft Dynamics GP
• Workflow for Microsoft Dynamics GP

Information is divided into the following sections:

• Installing web services metadata for Electronic Signatures
• Assigning tasks and operations to user roles
• Setting up electronic signatures workflow

Installing web services metadata for Electronic 
Signatures

To use the Electronic Signatures Workflow workflow type, you must run a process 
that adds electronic signatures metadata (tasks and operations) to the security store 
for the Dynamics Security Service. This process does the following things:

• Secures the web services that are used for the Electronic Signatures Workflow 
workflow type.

• Adds electronic signatures metadata (tasks and operations) to the Dynamics 
Security Service, and assigns them to the Superuser role. 

• Updates the eConnect_Out_Setup table.

• Creates the ElectronicSignatureDetailsView view and grants rights for the view 
to the DYNWORKFLOWGRP and DYNGRP groups.

Use this procedure to install the web server data for all Microsoft Dynamics GP 
companies using Windows® authentication. You must have permissions to add 
content to the security store that Web Services for Microsoft Dynamics GP uses. If 
you don’t have permissions to perform this operation, contact your system 
administrator.

To install web services metadata for Electronic 
Signatures:
1. Open a command prompt. 

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe”.
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You can use the following parameters with this application. If you use 
parameters, you must use them in the following order. You can run the 
application with either SQL credentials or Windows authentication. If you don’t 
provide credentials, the Windows credentials of the logged-in user will be used.

To install metadata for the sample company with SQL 
credentials:
1. Open a command prompt. 

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe 
/DATABASE=TWO /USER=sa /PASSWORD=123456”.

To install metadata for all companies with SQL 
credentials:
1. Open a command prompt. 

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe 
/USER=sa /PASSWORD=123456”.

To install metadata for the sample company with 
Windows authentication:
1. Open a command prompt. 

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe 
/DATABASE=TWO”.

To install metadata for all companies with Windows 
authentication:
1. Open a command prompt. 

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe”.

Parameter Description

/DATABASE The company for which web services will be installed.

/USER The SQL user whose credentials will be used to insert data in 
the eConnect setup table and to create the 
ElectronicSignatureDetailsView view.

/PASSWORD The password for the SQL user.
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Removing the web services metadata
When you remove the electronic signatures metadata, the tasks and operations will 
be deleted from Dynamics Security Services. Also, the 
ElectronicSignatureDetailsView view is deleted, and records are removed from the 
eConnect_Out_Setup table.

To remove the web services metadata:
1. Open a command prompt.

(Choose Start >> Run, type “cmd”, and then choose OK.)

2. Enter “cd: c:\Program Files\Microsoft Dynamics\GPWebServices”.

3. Enter “Microsoft.Dynamics.GP.Workflow.InstallELSSecurityMetadata.exe 
/REMOVE”.

Assigning tasks and operations to user roles

Use this procedure to assign electronic signatures metadata (tasks and operations) 
to user roles.

To assign tasks and operations to user roles:
1. Open the Dynamics Security Console window.

(Start >> Control Panel >> Administrative Tools >> Dynamics Security 
Console)

2. Expand Microsoft Dynamics Security >> Microsoft Dynamics GP Web Services 
and then click Roles. 

3. In the Roles list, select a role and then click the Properties link in the Actions 
menu. 

4. In the <Role> Properties window, choose Add to open the Add Role Definition 
window.

5. In the Tasks list, select All and then in the list on the right, mark View Electronic 
Signatures. 

6. Choose OK to save and close the Add Role Definition window. 

7. Choose OK to close the <Role> Properties window.

Setting up electronic signatures workflow

If your company uses the Workflow feature among its business controls, changes 
that require electronic signatures can be approved by someone who doesn’t use 
Microsoft Dynamics GP. When a change is made that causes the Signature Entry 
window to open, users can submit the change for workflow approval. The 
workflow task appears on the Microsoft Dynamics Workflow site, where an 
authorized person can approve it.
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To set up an electronic signatures workflow, open the Workflow web site, create a 
new workflow, and then select Electronic Signatures Workflow as the workflow 
type. For more information about Workflow, see the System Setup Guide (Help >> 
Printable Manuals >> select System >> select System Setup Guide) or the Workflow 
Administrator's Guide (Help >> Printable Manuals >> select System >> select 
Workflow Administrator's Guide).
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Chapter 4: Working with Electronic Signatures
This chapter provides information for the routine use of electronic signatures. The 
information is divided into the following sections:

• Approving a change with a password
• Viewing change history within electronic signatures
• Entering e-mail addresses for automatic notification
• Selecting a remote notification recipient
• Responding to remote notification
• Receiving remote notification response
• Submitting a change for workflow approval
• Approving a change with workflow

Approving a change with a password

When Electronic Signatures is enabled for a window, changes must be approved 
with authorized passwords. In the following procedure, a change to the Item 
Maintenance window is approved by entering the required password(s) in the 
Signature Entry window. Similar steps are used to approve changes to other 
windows for which Electronic Signatures has been enabled.

To approve a change with a password:
1. Open the Item Maintenance window.

(Cards >> Inventory >> Item)

2. Using the Item Number lookup button, select 100XLG.

3. Change the Description field to “xxxx.”
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4. Press the TAB key to attempt to leave the Description field. The Signature Entry 
window opens. Enter your password, and if required, select a reason code and 
description. The Signature Entry window may also require the user name and 
password from a second authorized signer.

If you don’t currently have the correct information, choose Cancel. Obtain the 
needed information and complete these steps again.

The Workflow button is available if you have Electronic Signatures workflow 
installed. 

5. The Signature Entry window closes and returns you to the original window (in 
this example, the Item Maintenance window).

Viewing change history within electronic signatures

Electronic Signatures data is captured and viewed in the View menu associated 
with each electronic signature, and in the Microsoft Dynamics GP Audit Trails 
module, if activated. (To view electronic signature history information in Microsoft 
Dynamics GP Audit Trails, refer to the Microsoft Dynamics GP Audit Trails 
documentation.)
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To view change history within electronic signatures:
1. Open the window to which an electronic signature has been attached and select 

a record that has been changed.

2. Select the electronic signature (Additional >> View Signature).

3. The Signature View window opens, displaying information about the most 
recent changes to the record.

If the field or window selected does not have an electronic signature assigned, a 
message appears.

4. Choose Save to save your changes and close the window.

Entering e-mail addresses for automatic notification

Use the User Mail Setup window to enter e-mail addresses for users who are 
assigned electronic signature passwords. E-mail addresses are used to automatically 
notify password holders of changes requiring approval. This window displays a list 
of password holders and their corresponding e-mail addresses.
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To enter e-mail addresses for automatic notification:
1. Open the User Mail Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Electronic 
Signatures >> User Mail Setup)

2. Select a user.

3. Enter the user’s e-mail address.

4. Choose Save; the User Mail Setup window will close.

Selecting a remote notification recipient

When an electronic signature is assigned to a window, an approver must enter a 
password before system changes can be saved. This section includes an example of 
authorizing a change to the Item Maintenance window using remote notification. 

To select a remote notification recipient:
1. Open the Item Maintenance window.

(Cards >> Inventory >> Item)

2. Using the Item Number lookup button, select 100XLG.

3. Change the Short Description field to “xxxx”:

4. Press the tab key to leave the Description field. The Signature Entry window 
opens.

5. Choose the Remote button.
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The Workflow button will be unavailable when you click Remote.

6. A list of users who are authorized to approve changes appears. Marked 
checkboxes indicate those who are currently logged into Microsoft Dynamics 
GP.

7. Select an authorized user to approve the change, enter a description, and choose 
Select. If an e-mail address has not been entered for the selected user, you will 
be prompted to enter one. You also can enter e-mail addresses using the User 
Mail Setup window.

8. Select a Microsoft Outlook® profile to notify the authorized user. The User IDs 
in the Requestor and Signed by fields cannot be the same.

The User IDs in the Requestor and Signed by fields can’t be the same. If you try 
to sign the signature using the same User IDs for requestor and approver you’ll 
receive a message, and won’t be allowed to continue.

9. After the request is sent, the Signature Entry window closes. You’ll receive a 
message that the request is pending approval. Click OK. 

10. Once the signature is sent, the original value of the field you changed is 
displayed. Close the window, any further changes to the window won’t be 
saved. If the change is approved, the changed value will be displayed when the 
window is reopened.

11. The authorized user receives a remote notification and then can view the 
request or postpone the change.

12. The user who is required to sign the document will receive an email message 
containing the request details.

13. After the authorized user responds, another message confirms their response.

Responding to remote notification

Remote Notification prompts electronic signature password holders to review and 
accept or decline change requests from remote Microsoft Dynamics GP users. This 
functionality enables the approval process across multiple sites.

After an approval request is sent, the approver is informed that a new request for 
signature is received. If the approver cancels the request, no further notifications are 
given about the new request. If the approver chooses to view the request, the 
Remote View Notification window opens. 



22 E L E C T R O N I C S I G N A T U R E S

To respond to a remote notification: 
1. When the Remote View Notification window opens, double-click the received 

record. Default entries are made to all the fields except the password field. The 
Remote notification menu can be opened from Microsoft Dynamics GP > Tools 
> Utilities > Electronic Signatures > Remote View Notification.

2. Choose the Expansion button and review the change requiring authorization. 
When you finish reviewing, close the document.

3. Change the status of the document. The available statuses are Tentative, 
Approved or Rejected.

4. Enter the password.

5. Choose Sign. The response is sent to the requestor.

6. Choose OK to close the window.

Receiving remote notification response

After the approver processes the request, the requestor will receive an alert message 
with request status. Request statuses are also visible in the Request Status window. 

If the change was approved:
1. You receive a message which informs you that the status has changed. Click Yes 

to view the document or click Postpone to close the notification window. If you 
choose Postpone, you will receive no further notifications regarding the request, 
and you’ll need to use the Request Status window to view the status.

2. If you chose Yes, the window with your requested change will open with your 
change displayed and you can continue making changes as needed. 

If you kept the window open and made any changes while the approval process was in 
place, only your approved change will be saved. 

When you’ve completed making your changes, click Save. The request will no 
longer be available in the Request Status window. 
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If the change was rejected:
You’ll receive a message which informs you that the change was rejected. Click 
Yes to view the original entries, or Postpone to view the window later. If you 
choose Postpone, you will receive no further notifications about the request.

If you open the window, the request will no longer be available in the Request 
Status window. 

Using the Request Status window
The Request Status window is used to review approved, rejected or tentative 
requests for changes, and allows the requestor to track the status of the request 
they’ve sent. Requests with Approved and Rejected statuses will be available 
until they are viewed or deleted. Tentative status requests can be deleted before 
they are approved or rejected.

1. Open the Request Status window.
(Microsoft Dynamics GP menu > Tools > Utilities > Electronic Signatures > 
Request Status)

You may need to click Refresh to redisplay any new requests in the window. 

2. Select the request you want to view.

3. Click View Request. The original window with the requested change will open. 
Once you view the request, it will no longer be listed in the Request Status 
window. 

If you’re viewing a Tentative request, the window will be display only, and you won’t be 
able to make changes until the request is approved or rejected. You can delete any 
tentative requests. 

Submitting a change for workflow approval

When Electronic Signatures is enabled for a window, changes must be approved 
with authorized passwords or through workflow approval. In the following 
procedure, a change to the Item Maintenance window is submitted to workflow for 
approval by using the Signature Entry window. Similar steps are used to approve 
changes to other windows for which Electronic Signatures has been enabled. For 
more information, see Approving a change with workflow on page 25.
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To submit a change for workflow approval:
1. Open the Item Maintenance window.

(Cards >> Inventory >> Item)

2. Using the Item Number lookup button, select 100XLG.

3. Change the Description field to “xxxx.”

4. Press the TAB key to attempt to leave the Description field. The Signature Entry 
window opens.

5. Enter your password, and if required, select a reason code and description. 
Click Remote to open the Remote Sign window.

6. Choose Submit for Signature. The Submit For Approval window opens.

7. Enter a comment and choose Submit. The change is submitted to workflow. 

8. The person who is authorized to approve electronic signature workflow tasks 
receives a notification and then approves or rejects the change.

9. When the change has been approved, close the Electronic Signatures window.



E L E C T R O N I C S I G N A T U R E S 25

Approving a change with workflow

If your company uses the Electronic Signatures Workflow feature among its 
business controls, and Electronic Signatures is enabled for a window, changes must 
be approved by using workflow approval. In the following procedure, a change to a 
Microsoft Dynamics GP window was submitted to workflow for approval by using 
the Remote Sign window. For more information, see Submitting a change for workflow 
approval on page 23.

To approve a change with workflow:
1. Open the Workflow Tasks Web page.

(Click a link in an e-mail message or other notification that you receive. 
Alternatively, you can go to the Workflow site and then click Tasks on the Quick 
Launch.)

2. Click the Electronic Signatures Tasks (Company Name) link.

3. Select a task.

4. On the Task Approval page, you can enter a comment.

5. Choose Approve to approve the electronic signature. The status of the 
workflow task changes to Approved. The change that was made in the original 
window becomes part of your company's permanent records.

Choose Reject to reject the electronic signature. The status of the workflow task 
changes to Rejected, and the change that was made in the original window is 
reverted to the previous value.
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